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Survey Procedure 
Revision 5 

   
 
A. Godley 
9/13/2001 
 
Revised by A. Sousa and D. Boehnlein 
January 07, 2003 
Change from Revision 4: Improved clarity of  the Download and Analysis Section. 
 
Calibrating the Vulcan is not necessary for every survey, in fact it is best if all the surveys 
are taken from the one good calibration.  The Vulcan will remain calibrated unless one or 
both of the transmitters are knocked, or, more drastically, the survey pole is bent or 
damaged.  Therefore, be extremely careful when turning the transmitters on and off. 
 

1) Turn on the two transmitters.  They take approximately 5 minutes to warm up. 
2) Whilst the transmitters are warming up, begin filling out the plane survey 

checksheet.  The checksheet should be filled out during the survey procedure 
insofar as it is practical to do so. 

3) Put on the belt and insert all three color-coded cables into the receiver hub. 
4) Attach the one foot pole to the 1.5-inch ball and the technical section.  When 

attaching the pole, be sure to twist the pole onto the technical section; never twist 
the technical section onto the pole.  Avoid bumping or otherwise putting stress 
on the technical section, as this can cause a misalignment of the sensors.  Once 
the pole is attached, the technical section is connected to the receiver hub with the 
green cable. 

5) Press button C then Bottom Detector- Tip and ensure that the short pole and 1.5-
inch tip are selected.  The pole selection is also displayed on the status bar at the 
bottom of the screen.  The pole(s) highlighted in yellow are selected. 

6) Once all connections are made, including the detector pole, turn on the power at 
the receiver hub.  The switch light should be a steady green.  If it is flashing 
green, cycle the power again.  Check that the handheld computer has a yellow 
light, either flashing or steady, which indicates that the computer is receiving 
power.  Press the power button on the handheld computer.  Start the survey 
program with button A. 

7) The first step is to check the calibration of the Vulcan.   Select a control point on 
the floor with a line of sight to both transmitters.  Remove the rubber stop and 
place the nest in the Dijak bolt. 

8) Select Measure then XYZ.  Position the tooling ball in the nest.   
9) When all 4 spheres on the status bar are green, coordinates should appear in the 

X, Y and Z boxes.  If any are red, check for line-of-sight blockage.  If they still 
don’t show up, or if the coordinates of the control point differ from the tabulated 
value (see Table 1) by more than .003 meter, go to Calibration Procedure.  If the 
calibration is OK, then replace the 1.5 inch sphere with the 0.75 inch sphere and 
proceed with the survey. 
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10) Press button C then Bottom Detector- Tip and ensure that the short pole and 0.75-
inch tip are selected.  The total distance should then read 0.45403. 

11) Make sure that the system is in “automatic” range-finding mode.  It is toggled 
between automatic and manual using the status bar tool to the right of the four 
spheres.  Manual mode is used only for calibration. 

12) Go back to Measure and then the Data menu. 
13) Press New to open a new file and then name to title it. 
14) Files are called SM1-<plane#>  e.g. SM1-17 
15) Press OK and Save.  Return to the XYZ screen and the name of the data file just 

entered will appear at the bottom of the screen.  The survey can now be taken. 
16) Diagrams are available indicating which points must be surveyed and how they 

are labeled for V (odd numbered) and U (even numbered) planes [This is valid for 
supermodule one; the numbering scheme changes with supermodule 2]. 19 
alignment holes, the 8 axial bolts, 8 points on the collar are surveyed, and two 
points on the ears just above the rails; a total of 37 points for most planes.  Every 
fifth plane includes 8 edge lugs, which are also surveyed.  Planes with edge lugs 
have 45 total points.   

o The axial bolts are labeled A1 through A8 with A1 being at the 1 o’clock 
position continuing clockwise to A8.   

o The collar points are C1 to C8, following the same pattern as the axial 
bolts.   

o The ear tab measurements are taken only for z information, so the x-y is 
just approximately the middle of the ear above the rail.  These are Z-EAR-
E (east side) and Z-EAR-W (west side).   

o The alignment holes have a three character label.  The first character is 
corresponds to the module number, 1 to 8, with module 1 being at the 
bottom of the detector.  The second is either B or T, referring to the 
bottom or top of the module respectively.  The final character refers to the 
alignment hole, 1 to 3, with 1 always being closest to the centerline of the 
plane. 

o The edge lugs are labeled S1 through S8 and follow the same pattern as 
the axial bolt and collar points.  These should be surveyed using the nest 
and the 1.5 inch sphere.  See step 24. 

17) To survey a point, determine its label and select it from the list available by 
pressing the small triangle at the end of the Label box. 

18) The labels are listed in the approximate order the points have been taken in 
previous surveys, however this order is NOT important. 

19) After the label has been selected, rest the 0.75-inch ball on the alignment hole or 
in the bolt (Axial bolts and collar) . 

20) Hold the pole as vertically as possible whilst ensuring the ball does not slip from 
the point. Holding the pole horizontally gives the worst performance of the 
system.  For points on the bottom of the plane, remove the pole and attach the 
tooling ball directly onto the technical section.  This allows the technical section 
to be held more vertically without hitting the floor.  When measuring points in 
this way, be sure to de-select the pole on the status bar and to re-select it when the 



Page 3 of 8  

pole is put back on.  Most points should be measured using the pole in order to 
minimize handling the technical section directly. 

21) The number 3.0 should be displayed on the status bar.  This is the time, in 
seconds, that it takes the Vulcan to calculate a position.  When the XYZ numbers 
have settled, press save.  A chime should be sound and the screen will display 
“Point X Collected” where X is the number of points surveyed so far. 

22) 18 points can be surveyed from the ground or 1st and 2nd levels (6 axial bolts and 
12 alignment holes.) The remaining 17 points must be reached from the Sky Jack 
or the bridge. 

23) If the plane has edge lugs (S1-S8), follow steps 25-28; otherwise go to step 29. 
24) Remove the 0.75-inch sphere and replace it with the 1.5-inch sphere. 
25) Place the nest in the 0.25-inch hole at the end of the edge lug. 
26) Take all 8 lug coordinates with the 1.5 inch sphere resting in the nest. 
27) Sometimes, whilst surveying points at the top of the plane, reception may be lost 

because of angle or distance, even if there is no blockage.  A possible remedy is to 
detach the pole and survey the point without it.  This may lower the sensors 
enough to get a good signal, but it also means more direct handling of the 
technical section.  Use this technique only if it is impossible to get a signal 
otherwise.  Remember to de-select and re-select the pole. 

28) To check what points have been saved, press back, and then Data and then View.  
This will display the labels of the points already taken in this data file.  This can 
be used to determine what points have been missed. 

29) A bad point can also be removed here, by pressing Delete and Yes. 
30) Back out and quit the program when all 37 (45) points have been saved.  Caution:  

Version 3.0 has records a point number with every measurement.  If a bad point is 
deleted and re-measured, the point number is not replaced but increased.  This 
means that the point number does not necessarily indicate the number of 
points in the data set.  If the number is greater than 37 (45), check to see if 
numbers are missing before assuming that there are really that many points in the 
data set. 

31) Turn off the receiver hub switch and  then the  hand-held computer. 
32) Unplug the cables and unscrew the pole.  Pack the Vulcan away. 
33) Turn off the Vulcan transmitters. 
34) Make sure that the plane survey checksheet is complete and file it in the 

documentation folder for the plane. 
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Download and Analysis of the Data 
 

1) The handheld computer (HHC) is not packed away, it is returned to the survey 
desk on the east side of the MINOS hall at floor level. 

2) Remove the HHC from its protective casing.  Ensure it and the desktop PC are on. 
3) Plug the serial cable into the rectangular connector at the base of the HHC.  This 

cable is permanently attached at the other end to the PC’s com port. 
4) The ActiveSync window will automatically appear on the PC. When it says it is 

synchronized, click on the Explore button of this window. 
5) Click on: 

MyPocketPC->ProgramFiles->Survey3DI->Data. 
6) Drag the current SM#-<plane#> file into the Survey folder on the PC’s desktop 

(in the top right corner.) 
7) Close the Explore and ActiveSync window. 
8) Unplug and turn off the HHC.  Remove it from its case and plug it into the 

charger. 
9) Open Excel.  There is an icon for it at the toolbar at the bottom of the screen. 
10) Open the SM# text file in Excel by clicking:  

File->Open->Desktop->Survey->SM#-<plane#>.   
It is necessary to tell Excel to look for “All Files”. It may be easier to find the  
Desktop folder in the left side column of the “Open”  dialog box. 

11) A window will appear, click next then check comma delimited and click next, 
then select the last column, and select text.  Finally click finish. The data will now 
appear in spreadsheet format. 

12) Highlight all the points and labels. In the Data menu, choose Sort, then select 
column E and ascending. This sorts the points into the order expected by the 
spreadsheet, no matter what order the points were surveyed in. Check that there 
are no double or extra points.  Delete those that are bad or unnecessary. 

13) Highlight and copy (ctrl-c) the 19 alignment point coordinates and labels.  Do not 
copy the point numbers. At this point, you can minimize the data sheet by clicking 
the first button in the upper left corner of the spreadsheet.  

14) Open the workbook todbase rev 2.  There are five worksheets in this file, but 
generally the surveyors will use only two: sm#-xxx, which will contain the data 
for the plane just surveyed; and Check sheet, which will contain the data from the 
last plane of the same type.  The other three worksheets calculate the positions of 
the B module alignment holes and perform QA checks.  These sheets are write-
protected. 

15)  The tab at the bottom of the spreadsheet indicates which worksheet is open.  
Click on the tab to open the sm#-xxx worksheet if it is not already open. Paste the 
data into the spreadsheet by clicking on cell A1 and then pressing ctrl-v.  Double-
click on the tab to edit the name of the worksheet.  Replace “xxx” with the plane 
number. 

16) Enter the plane number in the light blue cell as indicated on the spreadsheet.   
17) Double check that the labels of the points match with the expected labels in 

column E. 



Page 5 of 8  

18) All the number one alignment hole coordinates are displayed at the bottom. 
19) The spreadsheet automatically projects to determine the position of the number 1 

alignment holes at both ends of modules 2 and 7 (the B modules).  Check the 4 
red lettered cells next to each B alignment hole position.  The status of the QA 
check is indicated by a “passed”  or “FAILED”  flag.  If any fail the QA check, 
look at the point labels again to make sure that all of the B module points were 
properly entered. 

20) These coordinates must be compared with those of the previous U or V plane.   
The number “xxx” of the previous U or V plane can be found from the Check 
sheet tab in the todbase spreadsheet in the blue box next to the words “Enter Data 
for Plane”. 
The data corresponding to this plane is stored in: 

Desktop\Survey\Results\final-sm#\final sm#-xxx 
Open the file and make sure the correct worksheet is open by clicking on the sm#-
xxx tab.  There should be a blue box with the words “Use these data as checksheet 
for plane:” and the number should be that of the plane just measured.  Select the 
data from cell A1 to cell D19 by highlighting with the mouse and pressing ctrl-c.  
Now, close the current spreadsheet and go back to todbase, click on the Check 
sheet tab, click on cell A3 and press ctrl-v.  This will paste the contents of the 
final-sm#-xxx file into the check sheet. 

21) The check sheet makes a direct comparison between the two data sets.  Columns 
F, G, and H, starting at row 23, show the differences in the x, y, and z coordinates 
for each point.  The x and y values should agree to within 0.025 m and the z value 
should be greater by 0.10 to 0.15 meters (the coordinates are in meters). 

22) The columns to the right of the differences will flag either “OK” or 
“DEVIATION.” 

23) There are several reasons why a coordinate might be flagged as a deviation. 
o If the deviation is for a B module point, check the QA flag for the 

checksheet data.  If the B module position for the checksheet failed the 
QA test, then the deviation may simply indicate that the comparison data 
is faulty.  There’s nothing to be done about it at this point. 

o If there is just a single deviation it is probably due to a point being 
mislabeled. Check to see if the coordinates actually match a different 
point.  If the point is properly labeled and still in deviation, it should be re-
measured if possible.  If it is not possible to re-measure the point, make a 
note of the deviation on the survey QC sheet. 

o If all of the points are in deviation, it is probable that data from the wrong 
plane have been loaded into the check sheet.  Clear the Check Sheet data 
by selecting cells A1 to D19 and pressing the delete key.  Then go back to 
step 18, making sure to use the data from plane “xxx – 2,” i.e., for plane 
132 check against 130; for plane 133 check against plane 131, etc. 

24) Once the data agree, click the sm#-xxx tab to return to that worksheet. 
25) At this point, one needs to rename and store the todbase spreadsheet. From          

the File menu, “save as” the file as  
Desktop\Survey\Results\final-sm#/final-sm#-<plane#> . 
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26) Since all the necessary operations with Excel are completed at this point, close the 
program by clicking: 

File->Exit. 
Answer “no” to any prompts for saving files that may appear. 

27) Open the Survey folder by double clicking the icon located on the top right corner 
of the screen. Drag and drop the text SM#-xxx file in the Raw Data folder. Do not 
close this window yet. 

28) Post the data files on the world-wide web by double-clicking the WS-FTP95 icon 
on the computer screen followed by “ok”.  
a) In the “Remote System” window within the FTP session, double click the 

“raw data” folder.  Now, Select the raw data file and drag it with the mouse 
into the “Remote System” window. After a few seconds required to transfer 
the file, click the arrow “ ” on the upper right corner of the “Remote 
System” window and from the drop-down menu select: 

/home/survey 
b) In the Survey folder click the “back” ( ) button and go into: 

Results->final-SM# 
Now, drag the “final-sm#-xxx” file into the “Remote System” FTP window.  
After the file completes transferring, close the FTP session by clicking the × in 
the upper right corner of the window. 
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Calibration Procedure 
 

1) This procedure assumes starting from step 6 of the Survey Procedures, where no 
numbers appeared in the XYZ screen. 

2) Change to the 3 foot pole and the 1.5-inch ball. 
3) Press button C and then Bottom Detector-Tip and change to the long pole, 

deselect the short pole if necessary, and choose the 1.5-inch ball from the Custom 
list. The total length should be 1.06269. 

4) Attach the bipod to the pole.  The bubble should indicate that the setup is 
approximately level, but the most important thing is that it be stable.  Do not 
attempt to calibrate the system without using the bipod. 

5) Go to Setup->Calibration->Quick. 
6) Setup the ball and bipod above point 1 (review the diagram on the column below 

the east transmitter showing the approximate position of the calibration points, to 
help find them.) 

7) Level the pole, ensure that all 4 spheres are green, then collect the point.  The 
system will chime 4 times for each point collected. 

8) Collect all 6 points marked.  4 are in a rectangle between the two transmitters, the 
fifth is along the centerline towards the detector, the sixth is a few feet west of  
the 5th. 

9) Now press “Calibrate”.  If the calibration is unsuccessful, repeat the procedure.  
Otherwise proceed to the Scale Setup. 

10) Select two control points to be used for the scale.  The exact distance between 
them may be determined by using the distance calculator in the spreadsheet 
MINOS Survey Points.  This spreadsheet is on both the hand-held and desktop 
computers. 

11) Follow the instructions on the Set Scale screen.  Select square 1 at the top of the 
screen.  Then press the “Enter” button and enter the distance between the control 
points.  Select the check box in the second column and then de-select the check 
box in the first column.   

12) Select measure and set up to measure the first endpoint of the scale, using the nest 
and the 1.5” sphere. 

13) The Vulcan should be in precision measurement mode, indicated by a check mark 
in the far right box on the status bar.  This mode requires two sets of 3 
measurements for each endpoint.  Take the first three measurements by pressing 
the save button, then loosen the bipod just enough to rotate the pole 180°, re-
tighten it, and take three more measurements. 

14) A set of standard deviations will now be displayed.  They should all be less than 8 
8 mm (0.008 m).  If any of the standard deviations are 8 mm or greater, take the 
measurements over again, taking care to keep the pole steady. 

15) Repeat this process for the second end point. 
16) If the measured distance is not the exactly the same as the scale bar value entered, 

select the first checkbox, deselect the second box, then re-select the second box 
and de-select the first.  Yes, it’s complicated, but this forces the system to use the 
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entered value as the scale.  This can be verified by checking that the value of delta 
in the second column is 0.000. 

17) The Vulcan is now calibrated with Transmitter 1 (1163) as the origin.  It must 
now be transformed to the detector origin, the center of the coil in plane zero. 

18) Go to Setup->Transform->Snap point. 
19) Select the file “MINOS_Survey_Points” from the list. 
20) 4 floor points and two column points will be used in the transformation.  Select 

points that are in the vicinity of the transmitters. 
21) Measure each of these points with the 1.5” sphere and nest in the precision 

measurement mode (check mark in the far right box on the status bar). 
22) The Fermilab coordinates for this point will be shown, double check that the z, 

horizontal distance from the plane, is sensible (i.e. that a wrong point has not been 
selected), and then press Yes to accept the point. 

23) The Vulcan will then determine its coordinates for this point. Press save and then 
next. 

24) Repeat these steps for each of the four floor points, each time using the nest and 
leveling the pole. 

25) Remove the bipod and change to the one-foot pole. 
26) Go upstairs to the column points closest to the detector. 
27) Insert the nest into the central hole of the construction block that has been welded 

to the column.  The nest will only fit into this hole. 
28) Again select the point from the list and check its coordinates are sensible. 
29) When trying to record the column points it is general necessary to keep the pole 

as nearly vertical as possible.  When all four balls are green and the numbers have 
settled save the point and press next. 

30) Take the opposite column point. 
31) Press the Trans button instead of Next, when all 6 points have been saved. 
32) Hopefully “Result Success” will be shown.  If not, repeat the procedure more 

carefully.  Note though, that the transformation points can be taken in any order, 
i.e. the column points can be taken, then the floor points. 

33) The system is now ready to take measurements.  Cover all the survey monuments 
with their rubber stoppers and pack away the bipod and nest. 

 


